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1 About this document

1.1 Document function
This manual should support during the installation of the NXA82x units. It deals with the 
mechanical, electrical and signal line installation. The first commissioning steps are 
described as well.
Beside basic PC operating knowledge no special training is needed to perform the Tank 
Gauging System operations. Nevertheless it is recommended receiving a training on the 
system by Endress+Hauser

1.2 Symbols

1.2.1 Safety symbols

1.2.2 Electrical symbols

Symbol Meaning

A0011189-EN

DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will 
result in serious or fatal injury.

A0011190-EN

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in serious or fatal injury.

A0011191-EN

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in minor or medium injury.

A0011192-EN

NOTICE!
This symbol contains information on procedures and other facts which do not result 
in personal injury.

Symbol Meaning

A0011197

Direct current
A terminal to which DC voltage is applied or through which direct current flows.

A0011198

Alternating current
A terminal to which alternating voltage is applied or through which alternating current flows.

A0011200

Ground connection
A grounded terminal which, as far as the operator is concerned, is grounded via a grounding 
system.

A0011199

Protective ground connection
A terminal which must be connected to ground prior to establishing any other connections.

DANGER

WARNING

CAUTION

NOTICE

)

*
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1.2.3 Symbols for certain types of information

1.2.4 Symbols in graphics

1.3 Documentation
The following documentation types are available in the Downloads area of the 
Endress+Hauser website: www.endress.com/downloads

For an overview of the scope of the associated Technical Documentation, refer to the 
following: 

•W@M Device Viewer: www.endress.com/deviceviewer - Enter the serial number from 
the nameplate

•Endress+Hauser Operations App: Enter the serial number from the nameplate or scan 
the matrix code on the nameplate

1.4 Registered trademarks
Microsoft®, Windows® and Internet Explorer® 

Registered trademarks of the Microsoft Corporation

ModbusTM

Modbus is a registered trademark of Schneider Electric USA, Inc.

Java®

Registered trademark of Oracle® Corporation

Mozilla® Firefox®

Registered trademark of the Mozilla Foundation

Symbol Meaning

A0011193

Tip
Indicates additional information.

A0011195

Reference to page
Refers to the corresponding page number.

 ,  ,  ... Series of steps

A0018373

Result of a sequence of actions

Symbol Meaning

1, 2, 3 ... Item numbers

 ,  ,  ... Series of steps

A, B, C ... Views

A0011187

Hazardous area
Indicates a hazardous area.

A0011188

Indicates a non-hazardous location
Safe area (non-hazardous area)

1. 2. 3.

1. 2. 3.

-

.



Basic safety instructions Tankvision

6 Endress+Hauser

2 Basic safety instructions

2.1 Requirements for the personnel
The personnel for installation, commissioning, diagnostics and maintenance must fulfil the 
following requirements: 

• Trained, qualified specialists: must have a relevant qualification for this specific function 
and task

• Are authorized by the plant owner or operator
• Are familiar with federal or national regulations
• Before starting work, read and understand the instructions in the manual and 

supplementary documentation as well as the certificates (depending on the application)
• Follow instructions and comply with basic conditions

The operating personnel must fulfil the following requirements:

• Are instructed and authorized according to the requirements of the task by the facility's 
owner-operator

• Following the instructions in these Operating Instructions

2.2 Intended use

2.2.1 Application
Tankvision is a dedicated tank inventory management system.
Components:

• Tankvision Tank Scanner NXA820
scans parameters from tank gauges and performs tank calculations

• Tankvision Data Concentrator NXA821
summarizes data from various Tank Scanners NXA820

• Tankvision Host Link NXA822
provides data to host systems (such as PLC or DCS) via Modbus

The above mentioned components are operated via a standard web browser. It does not 
require any proprietary software. Tankvision is based on a distributed architecture on a Local 
Area Network (LAN). Due to its modular structure it can be adjusted to any application. It is 
ideally suited for small tank farms with only a couple of tanks, but also for large refineries 
with hundreds of tanks.

2.3 Workplace safety
For work on and with the device: 

• Wear the required personal protective equipment according to federal/national 
regulations.

• Switch off the supply voltage before connecting the device.

2.4 Operational safety
Risk of injury! 

• Operate the device only if it is in proper technical condition, free from errors and faults.
• The operator is responsible for interference-free operation of the device.

Modifications to the device
Unauthorized modifications to the device are not permitted and can lead to unforeseeable 
dangers!
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• If modifications are nevertheless required, consult with the manufacturer.

Repair
To ensure continued operational safety and reliability:

• Carry out repairs on the device only if they are expressly permitted.
• Observe federal/national regulations pertaining to repair of an electrical device.
• Use only original spare parts and accessories.

2.5 Product safety
This measuring device is designed in accordance with good engineering practice to meet 
state-of-the-art safety requirements, has been tested, and left the factory in a condition in 
which it is safe to operate. It meets general safety standards and legal requirements. It also 
complies with the EC directives listed in the device-specific EC Declaration of Conformity.
Endress+Hauser confirms this by affixing the CE mark to the device.
Furthermore, the device meets the legal requirements of the applicable UK regulations 
(Statutory Instruments). These are listed in the UKCA Declaration of Conformity along with 
the designated standards.
By selecting the order option for UKCA marking, Endress+Hauser confirms a successful 
evaluation and testing of the device by affixing the UKCA mark.

Contact address Endress+Hauser UK:
• Endress+Hauser Ltd.

Floats Road
Manchester M23 9NF
United Kingdom
www.uk.endress.com

2.5.1 Degree of protection
• IP20 (as per IEC/EN 60529)
• IK06 (as per IEC/EN 62262)

2.6 IT security
We only provide a warranty if the device is installed and used as described in the Operating 
Instructions. The device is equipped with security mechanisms to protect it against any 
inadvertent changes to the device settings.

IT security measures in line with operators' security standards and designed to provide 
additional protection for the device and device data transfer must be implemented by the 
operators themselves.

Endress+Hauser can be contacted to provide support in performing this task.
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3 Incoming acceptance and product identifica-
tion

3.1 Incoming acceptance
Upon receipt of the goods check the following:

• Are the order codes on the delivery note and the product sticker identical?
• Are the goods undamaged?
• Do the nameplate data match the ordering information on the delivery note?
• If required (see nameplate): Are the Safety Instructions (XA) enclosed?

If one of these conditions is not satisfied, contact your Endress+Hauser Sales Center.

3.1.1 Delivery content
• Tankvision
• Ferrules for installation on the power supply cable
• Installation Instructions BA00340G/00
• Documentation CD-ROM

3.2 Product identification
The following options are available for identification:

• Nameplate specifications
• Extended order code with breakdown of the device features on the delivery note
• W@M Device Viewer: Enter the serial number from the nameplate

www.endress.com/deviceviewer
• Endress+Hauser Operations App: Enter the serial number from the nameplate or scan the 

matrix code on the nameplate
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Nameplate

nameplate_2

1 Address of manufacturer
2 Device name 
3 Order code 
4 Serial number (Ser. no.) 
5 Data Matrix Code
6 Degree of protection
7 Certificate and approval relevant data
8 Technical data of the Service LAN port
9 Barcode
10 CE mark
11 MAC address of the System LAN port and Sync LAN port
12 Admissible ambient temperature
13 Type of fieldbus communication (only for Tank Scanner NXA820)
14 Supply voltage

3.3  Manufacturer address
Endress+Hauser SE+Co. KG
Hauptstraße 1
79689 Maulburg, Germany
Place of manufacture: See nameplate.

3.4  Storage and Transport,
Pack the measuring instrument so that it is protected against impacts for storage and 
transport. The original packing material provides the optimum protection for this.
Permissible storage temperature: –40 to +85 °C (–40 °F to +185 °F).
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4 Installation

4.1 Mounting

4.1.1 Dimensions

NXA82xxx-06-00-00-yy-002
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4.1.2 Installation conditions
• Maximum installation height for the device is 2000 m above sea level.
• The DIN-rail housing must be mounted outside hazardous areas in a cabinet.
• The housing has to be on a DIN rail EN 60715 TH 35x7,5 or TH 37x15.
• Do not install the instrument in the vicinity of high-voltage lines, motor lines, contactors 

or frequency converters. The installation regulations for high-voltage lines, motor lines, 
contactors or frequency converters must be observed.

• To ensure easy mounting and opening of the housing, a distance of approx. 1 cm (0.39 in) 
should be kept between the instruments.

# Warning! 
Risk of electric shock due to open parts under voltage, if housing is damaged!
Housing is protection class IK06: Install device in a stable installation cabinet.

4.1.3 Mounting

L00-FMU90xxx-17-00-00-xx-002

A  Attaching the instrument to the rail 
B  Detaching the instrument from the rail

4.2 Installation check
After installing the device, carry out the following checks:

• Is the device damaged (visual inspection)?
• Does the device correspond to the measuring point specifications such as ambient 

temperature etc?
• If available: Are the measuring point number and labelling correct?
• Is the instrument sufficiently protected against rainfall and direct sunlight?
• Is the instrument securely mounted to the DIN rail (visual inspection)?

A B

1.

2.

1.

2.

EN 60715
TH 35x7.5/15
(1.4x0.3/0.6)

mm (in)
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5 Wiring

5.1 Wiring examples

5.1.1 Wiring example for NXA820/821/822

NXA82x_Wiring_example

1 DCS/PLC (Distributed control system/Programmable logic controlled)
2 Modbus
3 Host Link NXA822
4 Data Concentrator NXA821
5 Switch
6 Operator with Browser
7 Tank Scanner NXA820
8 Fieldbus protocol

NXA820 NXA820

NXA822

NXA820

1

7

3

4

5

6

2

88

7
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5.1.2 Wiring example for NXA820 "Interface only"

NXA30_Wiring_example

1 DCS / PLC (Distributed control system / Programmable logic controlled)
2 Host Link NXA822
3 OPC Server (Open Platform Communications)
4 FieldCare
5 Tankvision Professional NXA85 Workstation
6 Switch
7 Ethernet
8 Tank Scanner NXA820
9 Fieldbus protocol (Modbus, Sakura V1, Whessoe WM550)
10 Modbus RTU RS 232/485 or Modbus TCP

5.2 Terminal assignment

L00-NXA82xxx-04-00-00-yy-020

A  Power supply 
B  Fuse 
C  Status relay 
D  System LAN port 
E  Sync Link LAN port 
F  Service LAN port
G  Endress+Hauser CDI port 
H  Display port 
I  USB port 
J  Weights & Measures locking switch

1 2

6

7
8

999

10

88

5

NXA30NXA30NXA30

1 3 4

2
3

1
6

7
8

W &M

RESET

RESET

NXA Status
Relay

E

L+

L-

6
7

8
3

2
1

Fuse

P
O

W
E

R

1
0
,5

 .
..
 3

2
V

 D
C

2 A T

A

B

C

D

E

F

G H I

J
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5.2.1 Power supply

WARNING!

When using the public supply mains, an easily accessible power switch must be installed in 
the proximity of the device. The power switch must be marked as a disconnector for the 
device (IEC/EN 61010)

WARNING!

Replace fuses only with fuses of the same type and value!

Please check the device designation on the nameplate.

Overvoltage Protection

Power supply: 2 x HAW561

Surge arrester HAW651K
• for low voltage users 24/48 V, single pole, requirement class C, basic component with 

plugged in protection unit, defect display, 18 mm (0.71 in) housing width. Order code: 
51003569

• for standard voltage users 115/230 V, single pole, requirement class C, basic component 
with plugged in protection unit, defect display, 18 mm (0.71 in) housing width. Order 
code: 51003570

L00-NXA820-04-00-en-001

A Tankvision
B Power supply: 2 x HAW561
C Ground connection

NOTICE
Signal input protection
Risk of overvoltage.
‣ The signal input with the NXA820 can be protected by a suitable overvoltage protection, 

additionally to the overvoltage protection which is integrated in the instrument.

Terminal 
Clamp

Meaning for AC version (90 to 250 VAC) Meaning for DC version (10.5 to 32 VDC)

1 L L+

2 N L-

3 Potential equalization Potential equalization

Fuse 400 mA T Fuse 2 A T

A

BC
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Wiring of DC Variants

To meet the emission class A1), it is mandatory to install the enclosed ferrite as close as 
possible to the power supply connector of the device. If this is not possible an additional line 
filter can be installed.

L00-NXA82xxx-04-00-00-xx-001

A  Terminal clamp 
B  Ferrite 
C  Fixation (e.g. cable straps)

The delivered ferrite must be installed as follows:

Put over the cable (prior installing the core cable ends).

The ferrite must be installed and secured against slipage next to the terminal clamp (e.g. 
with 2 cable straps).

5.2.2 Status Relay

The depicted switching state of the relay refers to the de-energized state.

5.2.3 LAN connection

1) DIN EN 55011: Industrial, scientific and medical (ISM) radio-frequenzy equipment - radio disturbance characteristics - limits and methods of 
measurements

2
3

1
6

7
8

W &M

RESET

RESET

NXA Status
Relay

E

L+

L-

6
7

8
3

2
1

Fuse

P
O

W
E

R

1
0

,5
 .

..
 3

2
V

 D
C

2 A T

1
0

1
1

1
2

1
3

1
0

1
1

1
2

1
3

MODBUS

A

B

C

1.

2.

Terminal 
Clamp

Meaning Remarks

6 normally open contact • NXA operating normally:
terminals 7 & 8 are interconnected

• NXA powered off or fault status condition:
terminals 6 & 8 are interconnected

7 normally closed contact

8 switching contact

Socket Meaning Remarks

System LAN port Connects the instrument to the network.

Sync Link LAN port
(in preparation)

Used for connection to redundant unit.
If the primary unit fails, its task is taken over by the redundant 
unit.

Service LAN port Connects the instrument to a computer locally for service 
purpose. Only this instrument can be configured. The Service LAN 
port does not allow access to the network.
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5.2.4 Additional elements in the terminal compartment

5.3 Terminal assignment Field connection - Tank 
Scanner NXA820

L00-NXA82xxx-04-00-00-xx-004

A  Power supply 
B Fuse
C  Status relay 
D  Fieldbus connection 
E  Ground 
F  System LAN Port 
G  Sync Link LAN port 
H  Service LAN port 
I  Endress+Hauser CDI port 
J  Display port 
K  USB port 
L  Weight & Measures locking switch

5.3.1 Field connection - Tankvision Tank Scanner

NOTICE
Noise and electrical interference
Prevent noise and electrical interference between the signal and power cables.
‣ Take care that the signal and power cables always are separated.

Symbol Meaning Remarks

Endress+Hauser CDI port Not used in the Tankvision instrument.

Display port For the connection of the local display in the housing cover.
Is connected on delivery.

USB port Reserved for future enhancements.

W&M
Weights & Measures 
Switch

•  :W&M parameters are unlocked and can be changed.

•  :W&M parameters are locked and cannot be changed.

2
3

1
6

7
8

W &M

RESET

RESET

NXA Status
Relay

E

L+

L-

6
7

8
3

2
1

Fuse

P
O

W
E

R

1
0

,5
 .

..
 3

2
V

 D
C

2 A T

1
0

1
1

1
2

1
3

1
0

1
1

1
2

1
3

MODBUS

A

B

C

D

F

G

E

H

I J K

L

Terminal 
Clamp

Modbus RS4851)

NXA820 - *4*********
Sakura V12)

NXA820 - *8*********
Whessoe WM5503)

NXA820 - *1*********

10 A Data signal (-) B Data signal (+) - Data signal (-)

11 B Data signal (+) A Data signal (-) + Data signal (+)

12 C Signal Common Not connected Not connected
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5.3.2 Additional information on Modbus RS485

Connection

As described in the “Modbus over serial line specification and implementation guide V1.02” 
published by the Modbus-IDA organisation (www.modbus.org) and based upon the EIA/
TIA-485-A physical layer specification, Modbus two-wire serial requires the following four 
electrical connections between each of the devices on the bus.:

Additional bus settings

• Bus biasing resistors (must be present at one point on the bus) (always enabled inside 
NXA820)

• Bus termination resistor (must be present at each end of the bus) (software selectable 
inside NXA820)

Cable Specification

13 S Capacitive Shield S Capacitive shield Not connected

Ground Ground Ground

1) For details → ä 17

2) For details → ä 18

3) For details → ä 18

Terminal 
Clamp

Signal Purpose Remarks

10 A Data signal (-)
These signals must be connected using a balanced twisted pair cable.

11 B Data signal (+)

12 C Signal 
Common

Must interconnect all devices on the bus.

13 Shield EMC 
Protection

Copper braided or combined foil and braided shielding.

Characteristic impedance 135 to 165 Ω at measuring frequency of 3 to 20 MHz

Cable capacitance ≤ 30 pF/m

Core cross-section ≥ 0.34 mm2 (AWG 22) multi-strand cable is preferred

Cable type Single twisted pair + third conductor (for common)
or
Dual twisted pair (common uses second pair with wire joined together)

Cable resistance ≤ 110 Ω/km

Signal damping Max. 9 dB over the entire length of the cable cross-section

Shielding Copper braided shielding or combined foil and braided shielding

Terminal 
Clamp

Modbus RS4851)

NXA820 - *4*********
Sakura V12)

NXA820 - *8*********
Whessoe WM5503)

NXA820 - *1*********

)
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5.3.3 Additional information on Sakura V1

Connection

V1 Definition

V1 fieldbus is a voltage mode digital communication using up to ±30 VDC, and requires the 
following three electrical connections between each of the devices on the bus:

V1 Cable specification

5.3.4 Additional information on Whessoe WM550
The WM550 communication protocol works using a current loop principle. 

Connection

Please take into consideration that the principle of current loop connection works as follows:

The Tankvision (master) (-) signal point connects to slave 1 (+) signal point. Slave 1 (-) 
signal point connects to slave 2 (+) signal point until (the last) slave N (-) signal point 
connects back to the Tankvision (master) (+) signal point closing the current loop.

Terminal 
Clamp

V1 Meaning Remarks

13 S Capacitive Shield

–
12 – Not connected

11 A –

10 B –

) Ground – Must be independently connected directly to a 
primary grounding point using 4 mm2 cable.

Signal Purpose Remarks

A Data signal (-)
These signals must be connected using a balanced twisted pair cable.

B Data signal (+)

Shield EMC protection Copper braided or combined foil and braided shielding

Cable capacitance ≤ 50 nF/m

Core cross-section ≥ 0.9 mm2 (AWG 17) multi-strand cable is preferred

Cable type twisted pair

Cable resistance ≤ 30 Ω/km

Shielding Copper braided shielding or combined foil and braided shielding

Insulation ≥ 60 VDC

Terminal Clamp Signal Purpose Remarks

10 - Data Signal Current Loop (-)

11 + Data Signal Current Loop (+)
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Cable specification

Please ensure to follow the following recommendations for field installation of the 
Tankvision with the WM550 protocol variant
• Cable with twisted and non-shielded pairs
• Cable with at least 0,5 mm² (20 AWG) section
• Maximum total cable resistance: 250 Ω
• Cable with low capacitance

5.4 Terminal assignment host/printer connection - 
Host Link NXA822 / Data Concentrator NXA821

This chapter is valid for Tankvision Host Link and Tankvision Data Concentrator with Printer 
Port option.

L00-NXA82xxx-04-00-00-xx-005

A  Power supply 
B  Fuse 
C  Status relay 
D  System LAN port 
E  Sync Link LAN port 
F  Service LAN port
G  RS232 Host connection (Host Link or Printer Connection Data Concentrator 
H  RS485 Host connection 
I  Endress+Hauser CDI port 
J  Display port 
K  USB port 
L  Weights & Measures locking switch

5.4.1 Host connection: Modbus Serial, EIA/TIA-232 (RS232)
The NXA822 Host Link is defined as a Data Terminal Equipment (DTE) device, and provides 
EIA/TIA-232 (RS232) interface through a male DB9 connector whose pin out complies with 
the EIA/TIA-574 standard:

Cross section (mm² (AWG)) Resistance (Ω/km) Capacitance (nF/km)

Cable 1 0,5 (20) 39.2 60

Cable 2 0,75 (18) 24.6 65

Cable 3 1,3 (16) 14.2 75
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Pin RS232 Name Remarks

1 CD Carrier Detect Signal from connected device

2 RxD Receive Data Signal from connected device
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Definition

EIA/TIA-232 (RS232) is a voltage mode digital communication using up to ±12 VDC, and 
requires a variety of signals depending on the operating mode (software selectable):

RS-232 Cable Specification

3 TxD Transmit Data Signal to connected device

4 DTR Data Terminal Ready Signal to connected device

5 G Signal Ground Common connection

6 DSR Data Set Ready Signal from connected device

7 RTS Request To Send Signal to connected device

8 CTS Clear To Send Signal from connected device

9 RI Ring Indicator Signal from connected device

Case Shield Shield –

Signal Basic RS232 Fully RS232 with
Hardware Handshaking
(in preparation)

Remarks

Shield Required Required Copper braided or combined foil and braided shielding

G Required Required –

RxD Required Required –

TxD Required Required –

RTS – Required Null Modem connection, these two pins can be linked 
togetherCTS – Required

DTR – Required
Null Modem connection, these three pins can be linked 
togetherDSR – Required

CD – Required

RI – Optional Not required

Cable capacitance ≤ 50 pF/m

Core cross-section ≥ 0.34 mm2 (AWG 22) multi-strand cable is preferred

Cable type Single cable or twisted pair

Cable resistance ≤ 110 Ω/km

Signal damping Max. 9 dB over the entire length of the cable cross-section

Shielding Copper braided shielding or combined foil and braided shielding

Pin RS232 Name Remarks
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5.4.2 Host connection: Modbus Serial, EIA/TIA-485 (RS485)

Two-Wire Modbus Definition

As described in the “Modbus over serial line specification and implementation guide V1.02” 
published by the Modbus-IDA organisation (www.modbus.org) and based upon the 
EIA/TIA-485-A physical layer specification.

Modbus two-wire serial requires the following four electrical connections between each of 
the devices on the bus:

Additional EIA/TIA-485 bus settings

• Bus biasing resistors (must be present a one point on the bus) (software selectable inside 
NXA822)

• Bus termination resistor (must be present a each end of the bus) (software selectable 
inside NXA822)

Cable Specification

5.4.3 Host connection: Modbus TCP/IP (via System LAN port)

L00-NXA82xxx-04-00-00-yy-024

Terminal Clamp EIA/TIA-485
Modbus

Meaning Remarks

18 C Signal Common
Connector: Phoenix FKC 2,5HC/3-St-
5,08

17 B + signal

16 A - signal

Signal Purpose Remarks

A Data signal (-) These signals must be connected using a balanced twisted pair 
cable.B Data signal (+)

C Signal Common Must interconnect all devices on the bus.

Shield EMC Protection Copper braided or combined foil and braided shielding

Characteristic impedance 135 to 165 Ω at measuring frequency of 3 to 20 MHz

Cable capacitance ≤ 30 pF/m

Core cross-section ≥ 0.34 mm2 (AWG 22) multi-strand cable is preferred

Cable type Single twisted pair + third conductor (for common)
or
Dual twisted pair (common uses second pair with wire joined together)

Cable resistance ≤ 110 Ω/km

Signal damping Max. 9 dB over the entire length of the cable cross-section

Shielding Copper braided shielding or combined foil and braided shielding

Host
TCP/IP Client

Modbus
Master

NXA822
TCP/IP Server

Modbus
Slave

NXA820

Tank
Data 1.15

TCP/IP Connection

Port: #500

Modbus Request

Modbus Reply
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6 Operation station settings
Before configuring and using Tankvision, the following settings are necessary on the 
operator’s computer:

• Deactivate proxy server usage

6.1 Deactivate proxy server usage
Before configuring and using Tankvision it is necessary to deactivate the proxy server usage 
on the user’s computer. This can be configured in the web browser.

After deactivating the proxy server usage, it is no longer possible to access the internet. 
Only the Tankvision pages are available. If you need internet access on the operation 
station, it is possible to configure the browser in a way that it uses the proxy server for 
internet pages but not for Tankvision.
For details please contact your local network administrator.

6.1.1 Microsoft Internet Explorer
Open the Tools menu.

Select Internet Options.

Select the Connections tab.

Select the LAN Settings button.

Deactivate the option Use a proxy server for your LAN.

Confirm the setting by clicking the OK button.

6.1.2 Mozilla Firefox
Open the Tools menu.

Select Options.

Open the Advanced menu.

Select the Network tab.

Click Settings to open the Connection Settings menu.

Activate the option No proxy.

Confirm the settings by clicking the OK button.

1.

2.

3.

4.

5.

6.

1.

2.

3.

4.

5.
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7 Tankvision NXA820/821/822 User Interface
Tankvision provides an intuitive user interface allowing the user to quickly navigate through 
the system. The following sections illustrate various parts of the Tankvision user interface 
and their usage.

Home Page (NXA820 with calculations/821/822)

The_Homepage

Pos. Field Description

1 System Header Displays the Customer Logo or Graphic.

2 Navigation Tree Contains header bars corresponding to different functional objects or groups in 
the system.
Refer to "Navigation Tree" (→ ä 24) for details.

3 Main Header Displays the following information:
• The site name, tank name, Tankvision tag name or product name - 

depending on what is displayed in the Main View below the header
• The system date and time

The main header is displayed with a background color depending on the access 
rights of the user logged into the system:
• Grey: the user does not have configuration rights and can only view non-real 

time data.
• Orange: the user has configuration rights and can view real time data.

4 Metadata Header Displays the following information:
• The user name and the user type
• The language options link
• The help link
• The logout option

5 Main View Displays the screens that the user has selected to configure the settings and 
view the operational information. 
Refer to "Main View Section - Colors in Edit Data" (→ ä 25) for details.

1 2 3 4

6 5
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Home Page (NXA820 Interface only)

NXA30_Home_Page

Navigation Tree (NXA820 with calculations/821/822)
The Navigation Tree is shown on the left side of the screen. Typically, the Navigation Tree 
allows the user to navigate down to the tanks. The image of the expanded Navigation Tree 
is as follows:

6 Alarm and Event 
Panel

The Alarm and Event Panel displays the real time information about alarms and 
events.
Refer to "Alarm and Event Panel Section" (→ ä 26) for details.

Pos. Field Description

1 System Header Displays the Customer Logo or Graphic.

2 Main Header Displays the following information:
• The product name and Unit tag name
• The IP address of the Tank Scanner
• The system date and time

The main header is displayed with a background color depending on the access 
rights of the user logged into the system:
• Grey: the user does not have configuration rights and can only view non-real time 

data.
• Orange: the user has configuration rights and can view real time data.

3 Main View Displays the following information:
• The "About" link
• The logout option

Displays the screens that the user has selected to configure the settings and view the 
operational information. 
Refer to "Main View Section- Colors in Edit Data" (→ ä 25) for details.

Pos. Field Description

1 32
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Navigation_Tree_Detailed_EN

Main View Section - Colors in the Edit Data Area
The system displays different colors in the Edit Data area, based on the access rights of the 
user:

1. If the user has access rights, then the edit data area has a light grey and light yellow 
background on alternate rows. The Submit button to save the settings is enabled.

Pos. Field Description

1 Header The user can click on the text or the arrow of the Header to expand or collapse the 
branch. 
The Header name shows a number, which is dynamically appended. The number 
states the following: 
• Tanks: The number of tanks in the NXA820
• Products: The number of products defined in the system
• Alarm Groups: The number of alarm groups defined in the system
• Customized Groups: The number of tank groups defined in the system
• Transfers: The number of product transfer stages (Waiting, In Progress, 

Finished, and Aborted) defined in the system
• Users: The number of users defined in the system

The text will appear in bold and white when the header is in the expanded form.

2 Collapsed Arrow This type of arrow is displayed when the Header is in the collapsed position. Click 
on the collapsed arrow to expand the Header.

3 Collapse/Expand 
Navigation Tree

The user can click on this arrow to collapse or expand the Navigation Tree.

4 Expanded Arrow This type of arrow is displayed when the Header is in the expanded position. Click 
on the expanded arrow to collapse the Header.

5 Node The user can click on the Node to view the operational information on the Main 
View section. If a Node is selected, it will appear in red color.
The number of tanks in the group is appended to the Node name.

1 2

3

5

4
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NXA82x_Tank-Capacity-Table-Summary

2. If the user does not have access rights, then the edit data area has a light grey and dark 
grey background on alternate rows. The Submit button to save the settings is disabled.

NXA82x_Tank-Capacity-Table-Summary_Inactive

Alarm and Event Panel (NXA820 with calculations/821/822)
The Alarm and Event Panel displays the alarm and event information, which is dynamically 
generated by the system. 

Events (Overview)

Tab Description

Alarm Displays details of the alarms generated by the system.

Events Displays details of the events generated by the system.

Alarm & Events Displays details of the alarms and events generated by the system.
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8 Tankvision NXA820/821/822 Configuration
This chapter refers to NXA820 with calculations. For Tank Scanner with "Interface 
only" option → ä 42.

8.1 Logging into the Tankvision NXA820/821/822 
system

To integrate a Tankvision unit (i.e. a Tank Scanner NXA820, Data Concentrator NXA821 or 
Host Link NXA822) into the network, proceed as follows:

Connect a laptop to the service port of the Tankvision unit. Make sure that the laptop is 
configured to get a dynamic IP addresses from a DHCP server.

L00-NXA82xxx-04-00-00-yy-025

Open the internet browser and enter the following URL: http://192.168.1.1
The Tankvision login screen appears. The user ID (= User Login Name) and password are 
defined by the system administrator when adding a user to the system 
(see BA00339G/00/EN).

Login as Supervisor.

NXA82x_Login-Screen

1.
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Field Description

User ID Enter the appropriate user login name . 
The user login name is alphanumeric and case sensitive.

Password Enter the appropriate password.
The user password is alphanumeric and case sensitive. It consists of 3 to 8 
characters.

3.
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• Enter Super into User ID.
• Enter Super into Password.
• Click the Login button.

Tankvision displays the Home Page.

8.2 Common settings - Tankvision NXA820/821/822 
system

L00-NXA82xxx-16-00-00-en-001

8.2.1 Network settings
You are logged in as "Supervisor".

In the navigation tree, click the System Administration Header. It expands as follows:

NXA82x_Menu_System

stand alone /
subscription store

all other units

Network configuration

subscription store settings

customer additional settings

units

environment settings

Products

Users and users rights

device specific settings

global configuration store

1.
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Click Global Settings. Tankvision displays the screen as follows:

NXA82x_System-Screen

Click  on Network Settings to unfold it. Click  again on the subentry Network 
Settings. Tankvision displays the screen as follows:

NXA82x_Network-Settings

Enter the appropriate information in the relevant fields.

– The following parameters are mandatory: Unit Tag Name, Primary IP Address, Domain, 
Subnet Mask and HART Port.

– The required values of the parameters depend on your local network configuration. For 
more information please contact your local network administrator.

– Detailed information on the individual fields can be found in BA00339G, "Tankvision 
NXA820, NXA821, NXA822 - Description of Instrument Functions".

Click the Submit button to proceed. The system displays a confirmation box as follows:

2.

3.

4.

5.
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NXA82x_Network-Settings_Submit-Popup

Click the OK button to proceed, or click the Cancel button to exit.

After saving the settings, Tankvision displays a confirmation message.

Disconnect the laptop and connect the Tankvision unit to the network using the System 
LAN port. The Tankvision unit can now be operated from a computer within the LAN.

8.2.2 Subscription Store definition
In a typical Tankvision system, most configuration settings are common for all Tankvision 
units within the network. Therefore, the time required for the configuration of the system 
can be minimized by defining one of the units to be a Subscription Store. The configuration 
settings are only performed on this Subscription Store. These settings are then distributed to 
the other units within the network.
For each Tankvision unit (i.e. Tank Scanner NXA820, Data Concentrator NXA821 or Host 
Link NXA822) within the network it is necessary to define if it is a Subscription Store or if it 
receives its configuration from a Subscription Store.
To do so, proceed as follows:

Login to the Tankvision unit as "Supervisor" and navigate to the Global Settings screen 
→ ä 28. 
Click  on Customer Settings. 

Click  on Define Configuration Store Details. Tankvision displays the screen as 
follows:

NXA82x_Define-Configuration-Store-Details

For the Subscription Store:

– In Configuration Store Type select the option Subscription Store (Default)

For the other units:

– In Configuration Store Type select the option Use Global Configuration Store
– In Subscription Store select the Subscription Store to which this unit is to be linked
– In Allow Local Configuration Change define whether local configuration changes of this 

unit are allowed in case the Subscription Store is not available.

Click the Submit button to proceed, or click the Refresh button to reset the screen.

After saving the settings, Tankvision displays a confirmation message. 

With the use of global configuration store the following information is transferred to the 
subscription units:

6.

7.

8.

1.

2.

3.

4.

5.



Tankvision Tankvision NXA820/821/822 Configuration

Endress+Hauser 31

• Customer settings like site information (without customer specific logo), unit, e-mail 
server and day and time settings (configurations of languages and printer agent must be 
done for every single device)

• Environment settings
• Products
• Users including user access rights

Global settings is recommended if the synchronization of a new product or other 
information is required between the units. Once the synchronization is completed and 
there is no new or changed information available for synchronization, the Global 
settings can be switched off again. To do so, on the devices which are configured as 
subscription units, deselect the option Use Global Configuration Store and select the 
option Subscription Store. This reduces CPU load and improves system stability. 

It is highly recommended to use an NXA820 as subscription store.

8.2.3 Further common steps (stand alone or subscription store)
Login to the Tank Scanner NXA820 as "Supervisor" and perform the following configurations 
(for details refer to BA00339G/00/EN "Tankvision NXA820, NXA821, NXA822 - 
Description of Instrument Functions"):

Customer Settings and Environment Settings

In the navigation tree, click the System Administration header.

Click Global Settings (below the System Administration header).

In the main screen click the Customer Settings header and configure the parameters.
For a description of the parameters refer to BA00339G/00/EN. At least units, site 
information, day and time and Email server (if required).

In the main screen, click the Environment Settings header and configure the 
parameters. For a description of the parameters refer to BA00339G/00/EN.

Product Configuration

In the navigation tree, click the Configuration header. Click Products. 

Click  on Configure New Products to add a new product and define the product 
properties 

Click  on Product Overview to modify and delete Products. 
For a description of the parameters refer to BA00339G/00/EN.

Users and user access rights

In the navigation tree, click the System Administration header. Click Users.

Click on Group Access Rights to define the rights of the different users.

Click on Manage Users and create the required users.

8.2.4 Tank Scanner NXA820 specific settings
Login to the Tank Scanner NXA820 as "Supervisor" and perform the following configurations 
(for details refer to BA00339G "Tankvision NXA820, NXA821, NXA822 - Description of 
Instrument Functions"):

Field Scan Configuration

In the navigation tree, click the System Administration header.

Click Global Settings (below the System Administration header).

In the main screen, click the Field Scan header.

1.

2.

3.
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Click the individual headers of the Field Scan menu and configure the parameters2).
For a description of the parameters refer to

– BA00339G, Chapter 16.4 (Modbus)
– BA00339G, Chapter 16.5 (V1)
– BA00339G, Chapter 16.6 (WM550)

Tank Configuration

In the navigation tree, click the Configuration header.

Click Tanks (below the Configuration header).

In the main screen, select the tank you are going to configure and click the Modify 
button.

Click the individual headers of the tanks menu on the Tank Details tab (General 
Details, Capacity Details, ...) and configure the parameters. For a description of the 
parameters refer to BA00339G/00/EN.

Product-tank assignment

In the navigation tree, click the Tanks header.

In the list below the Tanks header select a tank.

In the main screen click the Assign Product tab.

Select the product from the drop-down list.

Click Submit to save the settings.

For details about tank-product assignment refer to BA00339G/00/EN.

Additional Settings

Depending on your requirements, you can perform numerous further settings. For details 
refer to BA00339G.

Start Field Scan

In the navigation tree, click the System Administration header.

Click Global Settings (below the System Administration header).

In the main screen, click the Field Scan header.

Click the Start/Stop Field Scan tab and then click on Start. Field Scanning is now active.

8.2.5 Data Concentrator NXA821 specific settings

Associate Tank Scanner

Assign the Tank Scanner NXA820 to the Data Concentrator NXA821:

Login to the Data Concentrator NXA821 as "Supervisor".

In the navigation tree, click the System Administration header.

Click Global Settings (below the System Administration header).

In the main screen, click the header Tank Scanner Unit And Tank Assignment.

Select all Tank Scanner units you want to assign to the Data Concentrator from the 
Available Units list and move them to the Selected Units list using the arrow buttons. 
All units in the "Selected Units" list will be assigned to the Data Concentrator.

2) The parameters can only be edited if the field scan is not currently active. If necessary, go to the ’Start/Stop Field Scan’ tab and stop the field scan.
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Click the Submit button to save the settings.

Additional Settings (like groups)

Depending on your requirements, you can perform numerous further settings. For details 
refer to BA00339G/00/EN.

For details refer to BA00339G/00/EN, "Tankvision NXA820, NXA821, NXA822 - 
Description of Instrument Functions"

8.2.6 Host Link NXA822 specific settings
The Host Link NXA822 provides an interface for a host system to access inventory data from 
the NXA820 unit.
To configure the Host Link settings, proceed as follows:

Login to the Host Link NXA822 as "Supervisor".

In the navigation tree, click the System Administration header.

Click Global Settings (below the System Administration header).

In the main screen, click the Field Scan header.
It contains the following subheaders which are used to configure the Host Link settings 
and to start the Host Link:

– Host Link Configuration
– Modbus TCP Configuration (if the Modbus TCP protocol has been selected).
– Modbus Serial Configuration (if the Modbus Serial protocol has been selected).
– Entis+ Configuration (if the Entis+ serial protocol has been selected)
– Start/Stop Host Link

For details please refer to BA00339G/00/EN, "Tankvision NXA820, NXA821, NXA822 - 
Description of Instrument Functions"

8.2.7 Configuration of W+M systems

Description of the sealing process

Locking mechanisms in Tankvision:

Connected PCs are registered in the system by assigning the MAC address. Once the system 
has been locked, only these PCs are accepted and can display calibrated data.
When the W+M switch is flipped, a checksum is calculated and set. 
This calculation is repeated every 8 hours. If this checksum deviates from that at the time of 
sealing, changes have been made to the system. It is no longer possible to modify W+M 
parameters, such as tank tables, units and print templates, once the W+M switch has been 
flipped.

Recommended procedure:

It is recommended to start calibrating the tank gauging system from the field devices via 
possible protocol converters and finish the process with the Tankvision inventory 
management system. When calibrating the Tankvision Tank Scanner or Data Concentrator, 
it is recommended to start with the unit used as the Global Configuration Store since the 
engineering units are configured centrally here. These units would then not have to be 
checked separately in the boxes assigned (→ ä 34).

6.
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Initial calibration and system modifications

Units

The units do not have to be configured if Use Global Configuration Store is selected. The 
units can be checked under System Administration → Tankscanners → Tank Scanner 
Unit → Customer Settings → Units. This view allows the user to choose between the unit 
schemes.

Units

Selecting the Unit 

The exact settings of the unit scheme selected can be checked under Advanced.

NXA82x_Units

Checking the Units

• An apostrophe may not be chosen as the thousand separator for W&M applications.
• If the Tankvision device retrieves the basic settings from another Tankvision device 
(Global Configuration Store), the units of this Tankvision device do not have to be 
checked. The name of the box (Subscription Store) that provides the basic settings can 
be found under System Administration → Global Settings → Customer Settings → 
Define Configuration Store Details.

NXA82x_Define-Configuration-Store-Details

Configuration Store Details
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Field device assignment

The field device assignment must be checked under System Administration → Tank 
Scanner Unit → Field Scan → Manage Field Scan Configuration-Modbus EIA485.

The following parameters have to be checked for Modbus EIA485:
• Baud rate
• Parity
• Gauge slave address: assignment to the tank ID/tank name
• Gauge type: assignment to the tank ID/tank name
• Modbus register map: assignment to the field device type (gauge type)

Manage_Field_Scan_Configuration_Modbus

Field Scan Configuration - Modbus

The following parameters have to be checked for the V1 protocol:
• Gauge slave address (DEC) assignment to the tank ID/tank name
• Gauge type assignment to the tank ID/tank name
• V1 map file assignment to the gauge type

Manage_Field_Scan_V1

Field Scan Configuration - V1 Protocol

The following parameters have to be checked for the WM550 protocol:
• Baud rate
• Loop current
• Gauge slave address assignment to the tank ID / tank name
• Gauge type assignment to the tank ID / tank name
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• WM550 map file assignment to the field device type (gauge type)

Manage_Field_Scan_Configuration_WM550

Field Scan Configuration - WM550 Protocol

To activate the simulation mode

Download the "simConfig.xml" file under Sytem Administration → Uploads → Generic 
Uploads.

Modify the "simConfig.xml" file according to the desired simulation and rename it.
Specify Tanks, Parameters, Units, Start, End and Step values. 
Specify the mode of simulation for the parameters: 
0: Parameter value equals Start value; 
1: Parameter value runs from Start value to End value in Step value per interval; 
2: Triangle wave simulation; 
3: Sine wave simulation

Download the modified and renamed file as a gauge map file (under Sytem 
Administration → Global Settings →Field Scan → Add Gauge Map File).

Enable the checkbox Activate Simulation Mode on the Field Scan Configuration page.

Activate the Field Scan. 
SIMULATION MODE is displayed in in red on the Main Header.

Tank table

The tank capacity details have to be loaded to check the tank table (Configuration → Tanks 
→ Select the tank under Select - select and confirm with Modify (see Fig. "Tank Selection") 
→ Select Capacity Details in the Tank Details tab (see Fig. "Tank Capacity Table 
Summary")).

1.

2.

3.

4.
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Tank_configure

Tank Selection

NXA82x_Capacity-Details

Tank Capacity Table Summary

Steps for checking the tank table:
• Check that the information in the Tank Capacity Table Summary is correct for the selected 

tank.
• Check whether the TCT is suitable for the relevant tank.

Clicking Show TCT file opens a browser window that shows the TCT in a tabular form 
(with the units in the configured format). Print by clicking Print TCT.
To store the TCT file on a PC, click the Get TCT file link. The system will perform an export 
of the TCT in XML form as a compressed file (.gz). All units in the file are SI units 
(independent from the configured format). The data in the TCT XML file are displayed in 
the "Table in XML Format" graphic.

Table in XML Format
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PC assignment

Access_Configuration

Tankvision Tank Scanner - PC Assignment

Every PC to be connected to the sealed system has to be registered. The PCs are registered 
under System Administration → Global Settings → W&M Seal → Access Configuration.
The registered devices are listed with their MAC address in the column on the left. The MAC 
address of the PC currently used is displayed in the column on the right.
Each PC has to be registered individually on every Tankvision box. If no PC is registered in 
the system, an error message is shown on the display of the Tankvision box once the W+M 
switch has been flipped.

L00-NXA820xx-07-00-00-xx-001

Error Message - No PC Registered in the System

During calibration acceptance, the list must be checked to ensure it only contains the MAC 
addresses of the Tankvision boxes and the PCs that should access the system. The PCs can 
be checked, for example, by loading the page above from every PC that should have access 
to the system and then comparing the MAC addresses (Registered Systems against Current 
MAC Address). The MAC addresses of the Tankvision box are provided on the nameplate.

NXA

NXA820_A30016011

INFOINFO

Access Configuration Er
F317:

0.0.0.0 02/12/2009
172.0.0.1 02:51:54 PM
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Sealing tank data

The tank data are sealed individually for every tank. The W+M values are selected under 
Configuration → Tanks → Select the Tank (Select + Modify) → Put Tank into Calibrated 
Status in the Tank Details tab.

NXA82x_Put-Tank-into-Calibrated-status

Sealing Tank Data

If the W+M switch is flipped, tanks can be removed from the calibrated status. This 
changes the calibration checksum. Removing a tank from the sealed system is 
equivalent to a system modification and must be accepted by an official from the 
Standards Authority.

Locking

The unit is locked by flipping the W+M switch on the Tankvision Tank Scanner NXA820.

L00-NXA82xxx-04-00-00-xx-002

A Tankvision W+M Switch 

Flipping the switch means that the settings checked under Sealing Tank Data (→ ä 39) are 
fixed and can no longer be modified, and that the values specified under Sealing Tank Data 
are displayed as calibrated values by the computers specified under PC Assignment. A 
master checksum is calculated approx. 2 minutes after the W+M switch is flipped. This 
master checksum can be called up under System Administration → Tank Scanner Unit → 
W&M Seal. After approximately 2 more minutes, the system performs the first check 
calculation. The subsequent calculations are then performed every 8 hours.

The following information is displayed:
• Date and time the page was loaded
• W&M switch status
• W&M CRC at sealing time
• Last calculated W&M CRC
• Last calculated CRC’s time stamp
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WM_Information

Tankvision W&M Seal

A modified checksum indicates that changes have been made to the system. The checksum 
must be documented (e.g. by printing out the screenshot, see Figure "Tankvision W&M Seal") 
and recorded in the acceptance report (e.g. by attaching the printout).

The checksum can be recalculated by switching the Field Scan off and then on again.

Checking the W&M display

The following steps must be taken to check the weights and measures display:
• The settings listed under Sealing Tank Data (→ ä 39) can no longer be modified. 
• A WM in front of the values for the Product Level, Product Temperature and Total 

Observed Volume indicates that the values are calibrated.
• The level and temperature information has to match that of the field devices.

Checking the printouts

All printouts from connected printers that cannot be officially verified must bear the 
annotation Measured values not calibrated and no measured values may appear as 
calibrated.

Initial calibration and changes to the Tankvision Data Concentrator NXA821

Tank Scanner assignment

The assignment between the Tank Scanner units and the Data Concentrator must be 
checked under System Administration → Dataconcentrators → Data Concentrator Unit 
→ Tank Scanner Unit and Tank Assignment.

Tank_Scanner_Unit_Assignment

Tankvision Data Concentrator - Tank Scanner Assignment

PC assignment

The locking procedure is the same as for the tank scanner (→ ä 39).

Stamp points for Tankvision Tank Scanner NXA820 and Data Concentrator NXA821

The stamp points are listed under Point 6 in type approval 4.454/08.10.
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8.3 Exit the Tankvision system
The user can exit the Tankvision system from any screen.

The session ends automatically after 5 minutes of inactivity (session timeout).

To exit the Tankvision system

Click the Logout link on the Main View. Tankvision displays the login screen.1.
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9 Tankvision NXA820 (Interface only) 
Configuration

9.1 Logging into the Tankvision NXA820 (Interface only) 
system

To integrate a Tankvision Tank Scanner NXA820 (Interface only) unit into the network, 
proceed as follows:

Connect a laptop to the service port of the Tankvision unit. Make sure that the laptop is 
configured to get a dynamic IP addresses from a DHCP server.

L00-NXA82xxx-04-00-00-yy-025

Open the internet browser and enter the following URL: http://192.168.1.1
The Tankvision login screen appears. The user ID (= User Login Name) and password are 
defined by the system administrator when adding a user to the system 
(see BA00339G/00/EN).

Login as Supervisor.

NXA82x_Login-Screen

• Enter Super into User ID.

1.
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Field Description

User ID Enter the appropriate user login name. 
The user login name is alphanumeric and case sensitive.

Password Enter the appropriate password.
The user password is alphanumeric and case sensitive. It consists of 3 to 
8 characters.

3.
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• Enter Super into Password.
• Click the Login button.

Tankvision displays the Home Page.

9.2 Overview - Tankvision NXA820 (Interface only) 
system

In the Overview screen, the primary values and the status information of the tanks 
connected to the Tank Scanner is displayed.

In the Main View, click Overview. It expands as follows:

NXA30_034_EN

9.3 Configuration - Tankvision NXA820 (Interface only) 
system

Login to the Tank Scanner NXA820 (Interface only) with "Supervisor" rights to perform 
settings. To view the settings, "Operator" rights are sufficient.

Click  on Configuration. The following screen is displayed: 

NXA30_003_EN

9.3.1 Customer settings
Click  on Customer Settings. The following screen is displayed: 

NXA30_005_EN

1.

1.

1.
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Date and Time

The system allows the user to configure date, time, time zone and the date-time formats.

To Configure Date and Time Settings
Click  on Date and Time. Tankvision displays the screen as follows: 

NXA30_006_EN

Enter the appropriate information in the relevant fields. 

Click the Submit button. A dialog is displayed that the change of time and date settings 
will result in a clean-up reset of the system.

NXA30_007_EN

Click the Yes button to proceed, or click the No button to cancel. 

After saving the settings, the Tankvision unit restarts automatically (wait approx. 3 
min).

User and Group Settings

Login to the Tank Scanner NXA820 as "Supervisor" to perform the user and group settings.

To view the "Manage Users" screen
Click  on User Settings. Tankvision displays the screen as follows: 

Field Description

Date Format Select the date format from the drop down list. This field allows you to set the required 
format for the date. This date format will be used to display the date.

Time Format Select the time format from the drop down list. This field allows you to set the required 
format for the time. This time format will be used to display the time on all the 
Tankvision screens.
Click Change to save the selected time format settings without causing a clean-up reset 
of the system.

Time Zone Select the appropriate time zone from the drop-down list.

System Date Enter the current date in the relevant date format. Alternatively, click on the calendar 
icon to choose the date.

System Time Enter the current time in the relevant time format.

Daylight Saving 
Enabled

Select this check box to enable the user to enter the appropriate daylight saving details.
Clear the check box to prevent the user from entering the daylight saving details.

Daylight Saving 
Status

This field displays the daylight saving status. The system displays the ACTIVE status, if 
the Daylight Saving Enabled check box is selected.

1.

2.

3.

4.

5.
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NXA30_008_EN

Click the User Settings link. The Manage Users – Users List View screen is displayed.

NXA30_009_EN

For details on how to perform the user and group settings, refer to BA00339G/00/EN. 

To view the "Group Rights" screen
Click  on Group Settings. Tankvision displays the screen as follows: 

NXA30_048_EN

Click the Group Settings link. The Manage Users – Group Access Rights screen is 
displayed.

NXA30_049_EN

For details on how to perform the user and group settings, refer to BA00339G/00/EN. 

9.3.2 Network settings
You are logged in as "Supervisor".

Click  on Network Settings. Tankvision displays the screen as follows:

NXA820_Interface-only_Network-Settings

2.

3.

1.

2.

3.

1.
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Enter the appropriate information in the relevant fields.

– The required values of the parameters depend on your local network configuration. For 
more information please contact your local network administrator.

– Detailed information on the individual fields can be found in BA00339G/00/EN, 
"Tankvision NXA820, NXA821, NXA822 - Description of Instrument Functions".

Click the Submit button to proceed. The system displays a confirmation box as follows:

NXA82x_Network-Settings_Submit-Popup

Click the OK button to proceed, or click the Cancel button to exit.

After saving the settings, the Tankvision unit restarts automatically (wait approx. 
3 min).

If you don’t know the correct IP address, please contact your local network 
administrator. If you want to use an isolated LAN network, use the IP address 
192.168.2.xxx and set the subnet mask to 255.255.255.0

9.3.3 Field Scan
The most important function of NXA820 is acquiring measured data from gauges installed 
in tanks. NXA820 receives measured data by means of field scanning. The measured data 
comprise tank parameters such as product level, product temperature, pressure, observed 
density, etc.

To Configure the Field Scan Settings 
Click  on Field Scan. Tankvision displays the screen as follows:

NXA30_011_EN

Manage Field Scan Configuration is device specific.

Field Protocol

In order to perform field scanning, the Field Protocol needs to be configured.

To configure the field protocol
Click  on Field Protocol. Tankvision displays the screen as follows:

2.

3.

4.

5.
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1.
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NXA30_012_EN

Enter the appropriate information in the relevant fields.

Click the Submit button. 

After saving the settings, Tankvision displays a confirmation message. 

Manage Field Scan Configuration – Modbus EIA 485

The Manage Field Scan Configuration - Modbus EIA 485 screen displays serial 
configuration details and gauge configuration details.
In this screen it is possible to select the address and the Modbus map to be used for each 
gauge.
Before changing the field scan configuration it is necessary to stop the field scan (→ ä 51).

To Manage the Field Scan Configuration using Modbus EIA485
Click  on Manage Field Scan Configuration - Modbus EIA485. Tankvision displays 
the screen as follows:

NXA30_013_EN

Field Description

Field Protocol Type Displays the field protocol.

Number of Retries Type in the number of retries for the system to initiate Field Scanning. This field indicates 
the number of retries, before a field scan failure for a gauge is determined by the system.
The data type used in this field is numeric. By default, the Tankvision system selects 3 as 
the Number of Retries.

Field Description

Baud Rate Select the baud rate for Modbus communication from the drop down list. Default 9600

Parity Select the parity of the Modbus signal from the drop-down list. Default no parity.

EIA485 Termination 
Resistor

Enables or disables the termination resistor on the fieldbus for RS485. Only needed for 
long fieldbus cables to reduce signal reflections.

Tank Configuration

2.

3.

4.

1.
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Enter the appropriate information in the relevant fields.

Click the Submit button. 

After saving the settings, Tankvision displays a confirmation message.

To activate the simulation mode

Download the "simConfig.xml" file under Configuration → Uploads → Generic 
Uploads.

Modify the "simConfig.xml" file according to the desired simulation and rename it.
Specify Tanks, Parameters, Units, Start, End and Step values. 
Specify the mode of simulation for the parameters: 
0: Parameter value equals Start value; 
1: Parameter value runs from Start value to End value in Step value per interval; 
2: Triangle wave simulation; 
3: Sine wave simulation

Download the modified and renamed file as a gauge map file (under Configuration → 
Field Scan → Add Gauge Map File).

Enable the checkbox Activate Simulation Mode on the Field Scan Configuration page.

Activate the Field Scan. 
SIMULATION MODE is displayed in in red on the Main Header.

Manage Field Scan Configuration - V1

The Manage Field Scan Configuration - V1 screen displays serial configuration details and 
gauge configuration details.
In this screen it is possible to select the address and the V1 map to be used for each gauge.
Before changing the field scan configuration it is necessary to stop the field scan (→ ä 51).

To Manage the Field Scan Configuration using Sakura V1
Click  on Manage Field Scan Configuration - V1. Tankvision displays the screen as 
follows:

Tank ID Each tank in the Tankvision system has a unique numerical value ranging from 1 to 15. 
This ID represents the network address used by NXA820 for scanning the Tank Data. 
Cannot be changed.

Tank Name Actual tank name, which can be modified here.

Enabled Select the check box to enable the field scanning of the respective tank.

Gauge Slave Address 
(DEC)

This field is enabled, if the "Enabled" check box is selected. Enter the gauge slave address, 
which is configured between the NXA820 system and the gauge for communication. The 
gauge slave address can be any number from 1 to 247.

Gauge type Select the appropriate Gauge Type from the drop-down list. This field is mandatory.

Modbus Register 
Map

Select the appropriate register map file for tank and gauge (only Registermaps 
downloaded to Tankvision can be used, → ä 51).

Ambient Temperature Configuration

Enabled Select the check box to configure the ambient temperature.

Gauge Slave Address Enter the slave address of the gauge providing the ambient temperature.

Gauge type Select the appropriate Gauge Type from the drop-down list. This field is mandatory.

Modbus Register 
Map

Select the appropriate Modbus Map File from the drop-down list. If the appropriate Map 
File is not available it must be added by the Add Gauge Map File function (→ ä 51).

Field Description

2.

3.

4.

1.
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5.

1.
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NXA30_019_EN

Enter the appropriate option in the relevant fields.

Click the Submit button.

After saving the settings, Tankvision displays a confirmation message. 

To activate the simulation mode

For a detailed description, → ä 48.

Manage Field Scan Configuration - WM550

The Manage Field Scan Configuration - WM550 screen displays serial configuration 
details and gauge configuration details.
In this screen it is possible to select the address and the Whessoe WM550 map to be used 
for each gauge.
Before changing the field scan configuration it is necessary to stop the field scan (→ ä 51). 

Field Description

Physical Interface Configuration

Pulse Period Defines the pulse period (comparable to the baud rate).

Pulse Amplitude Allows to amplify the signal in case of long cables or poor signal transmission.

Tank Configuration

Tank ID Each tank in the Tankvision system has a unique numerical value ranging from 1 to 10. 
This ID represents the network address used by NXA820 for scanning the Tank Data.

Tank Name Enter the user defined tank name into this field.

Enabled Select the check box to enable the field scanning of the respective tank.

Gauge Slave Address 
(DEC)

This field is enabled, if the Enabled check box is selected. 
Enter the gauge slave address, which is configured between the NXA820 system and the 
gauge for communication. The gauge slave address can be any number from 1 to 99.

Gauge type Select the appropriate Gauge Type from the drop-down list. This field is mandatory.

V1 Map File Select the appropriate V1 Map File from the drop-down list. If the appropriate Map File is 
not available it must be added by the Add Gauge Map File function (→ ä 51).

Ambient Temperature Configuration

Enabled Select the check box to configure the ambient temperature.

Gauge Slave Address Enter the slave address of the gauge providing the ambient temperature.

Gauge type Select the appropriate Gauge Type from the drop-down list. This field is mandatory.

V1 Map File Select the appropriate V1 Map File from the drop-down list. If the appropriate Map File is 
not available it must be added by the Add Gauge Map File function (→ ä 51).

2.

3.

4.
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To Manage the Field Scan Configuration using Whessoe WM550
Click  on Manage Field Scan Configuration - WM550. Tankvision displays the 
screen as follows:

Manage_Field_Scan_Configuration_WM550

Enter the appropriate information in the relevant fields.

Click the Submit button.

After saving the settings, Tankvision displays a confirmation message.

To activate the simulation mode

For a detailed description, → ä 48.

Field Description

Physical Interface Configuration

Baud Rate Defines the WM550 protocol baud rate. Possible values are 300, 600, 1200, 1800, 2400, 
4800.

Loop Current This field defines the current in the Whessoe WM550 loop to be set by the internal 
electronic. This current will be hold by the Master regardless the number of slaves that are 
connected. Possible values ranges between 16mA and 30mA.

Tank Configuration

Tank ID Each tank in the Tankvision system has a unique numerical value ranging from 1 to 15. 
This ID represents the network address used by NXA820 for scanning the Tank Data.

Tank Name Enter the user defined tank name into this field.

Enabled Select the check box to enable the field scanning of the respective tank.

Gauge Slave Address 
(DEC)

This field is enabled, if the Enabled check box is selected. Enter the gauge slave address, 
which is configured between the NXA820 system and the gauge for communication. The 
gauge slave address can be any number from 0 to 63 for the Whessoe WM550.

Gauge Type Select the appropriate Gauge Type from the drop-down list. This field is mandatory.

WM550 Map File Select the appropriate WM550 Map File from the drop-down list. If the appropriate map 
File is not available it must be added by the Add Gauge Map File function.

1.

2.

3.

4.
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Add Gauge Map File

For each Modbus field device you need a special map to recognize the device in Tankvision. 
By default basic maps for Tank Side Monitor (NRF), Proservo NMS and Micropilot NMR are 
present on the Tankvision Tank Scanner unit. Ask your local Endress+Hauser service to 
provide the correct map file.

To add a Gauge Map File
Click  on Add Gauge Map File - Modbus EIA485/Add Gauge Map File - V1/Add 
Gauge Map File - WM550. Tankvision displays the screen as follows:

NXA30_014_EN

Click the Browse button and navigate to the required gauge file. Double-click the file 
name to enter it into the Gauge Map File field. 

Click the Download File button to download the map file to the Tankvision unit. 

Click the Submit button to activate the gauge map file. 

Start/Stop Field Scan

This option allows the user to start the field scan after configuring the field scan. Similarly, 
the field scan can be stopped at any point of time by using this option.

To start or stop field scanning
Click  on Start/Stop Field Scan. Tankvision displays the screen as follows:

NXA30_015_EN

Click the Start button to start the field scanning. The Start button is enabled, if the field 
scan is not started. Once the field scan is started, the Start button is disabled, and the 
Stop button is enabled. To stop the field scanning, click the Stop button.

Service Interface

The requests from the Tank Scanner NXA820 and the ensuing responses from the field 
devices are evaluated in this screen. This screen is only for service purposes.

To display the service interface
Click  on Service Interface. Tankvision displays the screen as follows:

NXA82x_Service-Interface
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Alternatively, install the Service Interface application (refer to BA00339G).
Open the Service Interface application after successful installation and click the Start 
Stat Count button.
The application offers more detailed service information.

A separate operating manual for the Service Interface application is available and will 
be installed on the PC during the application installation process.
Click the Windows Start button and navigate to the Tankvision ServiceIface folder, 
where you will find the manual.

9.3.4 Uploads
Via the Uploads screen, additional apps can be installed and analysis logfiles can be copied 
to the PC.

Click  on Uploads. The following screen is displayed: 

NXA820_Interface-only_Uploads

Generic Uploads

Contains generic data to be uploaded from the Tankvision unit, e.g. diagnostic files.

Click  on Generic Uploads. Tankvision displays the screen as follows:

NXA820_Interface-only_Uploads_Generic-Uploads

Convert Configuration XML File

Converts XML files used in older versions of Tankvision to the latest structure.

Field Description

Requests Sent The number of total requests sent by the Tank Scanner NXA820.

Good Response The number of requests / percentage of total requests that got a good response from the 
field device.

Response with Error The number of requests / percentage of total requests that got a response with error from 
the field device.

Comm. Timeout The number of requests / percentage of total requests that got no response from the field 
device.

Stat Started/
Restarted Time

Time at which the evaluation was started; i.e. the time at which the Start Stat Count or 
Reset Stat Count button was pressed.
Press the Stop Stat Count button to stop the evaluation.

1.

1.
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To convert a Configuration XML file
Click  on Convert Configuration XML File. Tankvision displays the screen as 
follows:

NXA30_027_EN

Click the Browse button and navigate to the required Configuration XML file. Double-
click the file name to enter it into the Select an XML file for conversion field.

Click the Download button to download the XML file to the Tankvision unit.

Click the Convert button to convert the XML file.

Post Mortem Dumps

Post Mortem Dumps are log files generate when irregular behavior occurs.
Post Mortem Dumps are used for advanced service operations only and should not be used 
for normal operation.

Click  on Post Mortem Dumps. Tankvision displays the screen as follows:

NXA30_028_EN

OPC Server

An OPC Server is an application running on a PC serving data to an according OPC Client.

To install the OPC Server application
Click  on OPC Server. Tankvision displays the screen as follows:

NXA30_031_EN

Click the OPC Server link and execute the file. Follow the directions on the screen.

Tankvision Installation and Recovery Tool

The Tankvision Installation and Recovery Tool is an application running on a PC allowing the 
complete application and configuration of Tankvision unit to be saved as safety copy to a 
hard drive. It also enables the user to install an update to the latest version including the 
migration of the configuration.

The migration of the configuration is only possible when updating from version 
01.06.00 onwards (version before update) to a later version.

Tankvision Installation and Recovery Tool

Click on Tankvision Installation and Recovery Tool (zip file) under Configuration → 
Uploads → Tankvision Installation and Recovery Tool and save the zip file to your PC.

1.
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NXA82x_BNR_Install

The Tankvision Installation and Recover Tool requires no installation. Simply uncompress 
the Tankvision_Installation_and_Recovery_Tool.zip archive and copy the contents to your 
computer.

Use the Tankvision Installation and Recovery Tool

Backup

To create a backup job of a Tankvision unit, the Backup Location where it has to be saved 
must be selected with  (on the local PC or on a network drive) and the IP address must be 
filled. With Add the job will be added to the Job list. Multiple Tankvision backup jobs can be 
queued. Each job can be canceled by selecting the job line and use .
To start the backup jobs use Backup.

NXA82x_BNR_Backup

Restore

To create a restore job of a Tankvision unit, the Backup Location must be selected with  
(on the local PC or on a network drive) and the IP address must be filled. With Add the job 
will be added to the Job list. Multiple Tankvision restore jobs can be queued. Each job can be 
canceled by selecting the job line and clicking the  button.
To start the restore jobs use Restore.
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NXA82x_BNR_Restore

Flash

To create a flash job of a Tankvision unit, the location of the installation files must be 
selected with  (on the local PC or on a network drive) and the IP address must be filled. 
With Add the job will be added to the Job list. Multiple Tankvision flash jobs can be queued. 
Each job can be canceled by selecting the job line and clicking the  button.
To start the flash jobs use Flash.
To update a Tankvision unit and keep the configuration a backup must be taken first. Then 
the Backup location must be selected with  (on the local PC or on a network drive) in 
addition before adding the job. In this case the check box Flash with configuration must be 
active and if the archive data has to be transferred as well then the check box Flash with 
Archival.

The location where the backup is saved has to be unique for each Tankvision unit, if the 
same folder is selected the same backup would be used for each job and would lead to 
IP address conflicts in the network. 

Flash with Archival can only be selected if Flash with Configuration is selected as 
well.

NXA82x_BNR_Flash
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Patch

The Patch zip file contains some of the bug fixes binaries prepared for the specified software 
version. To apply the patch, the user must select the provided patch file and the Tankvision 
unit IP address. 
By clicking the Add button, the job will be added to the Job list. Multiple Tankvision patch 
jobs can be queued. Each job can be canceled by selecting the job line and clicking the  
button.
To start the patch jobs, click the Patch button.

NXA82x_BNR_Patch

Logs

The log files register all actions made by this tool and are saved on the PC. It can be cleared 
with Clear Log. With  the log file location can be changed.

NXA82x_BNR_Logs

About

About shows the version and the build date of the Tankvision Installation and Recovery Tool.
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NXA82x_BNR_About

Service Interface

The Service Interface is an application running on a PC allowing the analysis of the field 
communication of the NXA820.

To install the Service Interface
Click  on Service Interface. Tankvision displays the screen as follows:

NXA30_033_EN

Click the Service Interface link and execute the file. Follow the directions on the screen.

TCT Generator 

The TCT Generator is an application allowing the user to generate TCT files for NXA820.

To install the TCT Generator

 Go to Configuration > Uploads > TCT Generator, click on TCT Generator (zip File) 
and save the file to your PC.

Tankvision_TCT_Generator

Uncompress the saved folder and open the file index.html with a web browser.

Follow the instructions.

1.

2.
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9.3.5 W&M Seal
The W&M seal allows you to view the W&M sealing status and to perform the access 
configuration for W&M secured systems.

To Change the W&M Approved Status 

Click  on W&M Seal. Tankvision displays the screen as follows:

NXA30_035_EN

W&M Information

Click  on W&M Information. Tankvision displays the screen as follows:

WM_Information

Field Description

W&M Information Shows detailed information of sealing status for a device:
• W&M Switch status
• W&M CRC at sealing time
• Time of sealing
• Last calculated W&M CRC
• Last calculated CRC’s time stamp

Access Configuration Registration page to configure access rights for a PC that can access the device after 
sealing.

Field Description

This page is static 
and is loaded at:

Displays the date and time when the screen was locked. This is a static page meaning no 
auto update is running.

W&M switch status Displays the current W&M switch status.
The status can be sealed (closed W&M switch) or unsealed (open W&M switch).

CRC at sealing time A checksum is calculated with closing the W&M switch. This checksum is displayed in 
this field.

Time of sealing Displays the date and time the sealing took place.

Last Calc. W&M CRC Displays the latest calc. W&M checksum. The checksum is recalculated on a regular basis. 
In case of an mismatch of the recalculated checksum with the initial checksum, the 
system was manipulated.

Last Calc. W&M CRC 
time stamp

Displays date and time of the last calculated W&M checksum.

1.

1.
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Access Configuration

In sealed systems only registered Users/PC’s are allowed to have access to the system 
functionality. The access configuration provides the possibility to ensure the access. The 
access configuration is based on MAC Address.

NXA30_037_EN

This section is sealed for editing after switching the W&M switch to close.

9.3.6 Configuration of W+M systems
See configuration of W+M systems (→ ä 33) and follow the required steps for NXA820 
Interface only (Field Device assignment, PC assignment and Locking).

9.3.7 Tankvision Outputs
To set or manage the Tankvision Outputs
Click  on Tankvision Outputs. Tankvision displays the screen as follows:

NXA82x_Tankvision-Outputs

SupplyCare Configuration

Configure the parameters that the Tank Scanner NXA820 provides when polled by 
SupplyCare Enterprise.

To set or mange the SupplyCare Configuration

Click  on SupplyCare Configuration. Tankvision displays the screen as follows:

Field Description

Registered Systems Displays the MAC Address of the currently registered PC.
• Registered:

Registers the PC which is connected to the system (current workstation). The PC’s 
must be in the same Network as Tankvision (no router / gateway in between). 
Registration must be performed from every PC which should have access to the system 
individually.

• Unregistered:
To unregister PC(s) mark them in the list on the left hand side (select several by 
pressing Ctrl and marking them) and click unregister. The unregistered PC’s will not 
have access to the system after sealing.

Current MAC 
Address

Displays the current MAC Address of the workstation.

1.
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NXA82x_Tankvision-Outputs_SupplyCare-Configuration

Enter the appropriate information in the relevant fields.

Click the Submit button to save the settings, or click the Reset to Default button to reset 
the screen to the default values. 

After saving the settings, Tankvision displays a confirmation message, including the 
name of the .esp page which must be entered by the user in the Gateway configuration 
page of SupplyCare Enterprise. 

An event is generated after setting the Tankvision Outputs. The event details can be 
viewed in the Event overview. 

9.3.8 Redundancy configuration 
Redundancy setting is activated via order code feature 090.

The device Tankvision NXA820 Interface only provides a redundancy feature that works 
by means of the normal Ethernet as shown in below figure:

Field Description

Tank Select the tank from the drop-down list for which to configure the parameters that are 
provided for SupplyCare. 
Either configure each tank individually or select the All Tanks check box to configure the 
same parameters for all tanks.

Time Stamp Choose between the SupplyCare Time Stamp and the Tank Scanner NXA820 Time Stamp 
for the provided parameters.

Measurement Point 
Configuration

Configure the parameters for the tank(s) selected in the ’Tank’ field, that are provided 
when polled by SupplyCare.

2.

3.

4.
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NXA820_TaVi_Redundancy

1 Connection to PLC / Host (Serial / Ethernet)

2 PLC

3 Modbus TCP / Modbus Serial / Ethernet

4 NXA85 (secondary)

5 NXA85 (primary)

6 Switch

7 Primary Ethernet connection

8 NXA820i (primary)

9 Redundant Ethernet connection

10 NXA820i (secondary)

11 Fieldbus connection

The primary and secondary NXA820 devices should have same protocol type. I.e. the 
user cannot configure a Modbus NXA820 as primary and a V1 NXA820 as secondary.

In a normal scenario, the primary device is active and field scan is on to acquire measured 
data. Information like configuration, measured data and Heartbeat signal are exchanged 
periodically between the primary and secondary NXA820 devices.
The secondary NXA820 field scan is normally in standby mode. The secondary NXA820 
continuously monitors the health of the primary NXA820, and in case of a first-order failure, 
the secondary automatically takes over and starts scanning the field.

Some example of first-order failures are:

1. All connected gauges from the primary device fail

2. The primary device is not responding due to reasons like LAN failure, power failure and 
hardware damage

3. The primary device has a critical software failure like high CPU, crashed module, 
corrupted database, etc.

To configure the redundancy setting

Configure the network settings on both NXA820 devices.

Perform an NND configuration and configure both NXA820 devices.

Configure Field scan only on this NXA820 device, which will be configured as primary 
NXA820 device by the user later on. 

NXA820 NXA820

9

11

4

6

3

5

8

2

1

7

10

1.

2.

3.
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Click on Redundancy Settings from another NXA820, which will be configured as 
secondary NXA820 device by the user later on:

NXA820_TaVi_Redundancy_01

On the secondary NXA820: To activate the redundancy mode, select either option 
Switch by Gauge or option Switch by Interface from the dropdown list. Select 
Redundant Unit Type as Secondary. Select the associated primary NXA820 from the 
dropdown list.

NXA820_TaVi_Redundancy_02

Press the Submit button to activate redundancy. 

4.

5.

6.

Field Description

Activate Redundancy 
Mode

Switch by Interface
When all configured gauges fail, the system performs automatic switch-over.
Switch by Gauge
When one of the configured gauges fails, the system performs automatic switch- 
over.

Redundant Unit Type Select the NXA820 unit type as primary or secondary. For the secondary NXA820, 
select the associated primary NXA820 from the dropdown list.

Restore Redundancy Clicking the Restore Redundancy button configures the system back to the normal 
healthy state. Here, the primary NXA820 is active, scanning the field and the 
secondary is in standby mode. 

If the connected gauges or the primary unit fail, the secondary unit becomes active. 
The user can perform the following operations to bring the system back into the 
normal state: 

• Manual switch-over on Primary unit
• Repair the failure on the primary unit
• Once the primary unit and connected gauges are operational again, click the 

Restore Redundancy button to configure the system back into the normal state

Manual SwitchOver The Manual SwitchOver button is useful to take control for performing 
maintenance activities.
When clicking the Manual SwitchOver button redundancy is broken. This means, 
the redundant NXA820 devices do not observe each other, and no data are 
exchanged among them. Press the Submit button to activate redundancy again.

Reset to Default Selecting the Reset to Default option configures the redundancy settings of both, 
primary and secondary NXA820, back to factory default.
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9.4 Service - Tankvision NXA820 (Interface only)
Click  on Service. The following screen is displayed: 

NXA820_Interface-only_Service

9.4.1 Device Status Codes
The Device Status Codes are intended only for service tasks. Refer to BA00339G/00/EN for 
a detailed list of the status codes.

Click  on Device Status Codes. The following screen is displayed: 

NXA30_040_EN

9.4.2 System Diagnostics
The system diagnostic tools are intended for service operations only and should not be used 
for standard operations of the Tankvision system.

Click  on System Diagnostics. The following screen is displayed: 

NXA30_042_EN

Diagnostic Data

Diagnostic data provides general status and diagnostic information like the number of times 
restarted and the temperature limits reached. This is a valuable tool to recognize unsafe 
conditions that could become a future failure.

Click  on Diagnostic Data. The following screen is displayed: 

NXA820_Interface-only_Diagnostic-Data

User Session Statistics

Provides useful information of users and user login activities. It allows to know which user 
logged in last via a Last Accessed Time stamp.

Click  on User Session Statistics. The following screen is displayed: 

1.

1.

1.

1.

1.
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NXA30_043_EN

Service Codes

Service Codes is a service area that allows to execute predefined tasks by the operative 
system. As service codes are tasks like generate advanced diagnostic information, restart the 
unit, apply a historical archive clean up reset or execute a factory default settings reset.

Click  on Service Code. The following screen is displayed: 

NXA30_044_EN

Service Interface

Service Interface helps users to check the field communication health status. This is a web 
version of the Service Interface application which users can install on their computers.

Click  on Service Interface. The following screen is displayed: 

NXA30_044_EN_Se_Interface

9.5 Exit the Tankvision system
The user can exit the Tankvision system from any screen.

The session ends automatically after 5 minutes of inactivity (session timeout).

To exit the Tankvision system

Click the Logoff link on the Main View. Tankvision displays the login screen.

1.

1.

1.
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10 Diagnostics and troubleshooting

10.1 Test network connection
If a Tankvision unit can not be accessed from the operators computer you can test the 
network connection using the ’ping’ command:

Click the Window Start button and select Execute. The Run dialog window appears.

Enter cmd into the Open field. The Windows Command Prompt window appears.

Try to ping the Tankvision until by typing the following into the command prompt line:
ping xxx.xxx.xxx.xx
Here xxx.xxx.xxx.xx is the IP address of the Tankvision unit.

If the pinging is successful and the computer receives an answer from the Tankvision 
unit, a message appears as follows:

If the pinging fails, the message "Destination host unreachable" or "Request timed out" 
will appear: This means that the network is not working properly.

1.

2.

3.

4.

5.
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Possible causes are:
• Wrong network settings (e.g. wrong IP address) in the Tankvision unit or the computer
• Hardware problems (e.g. cable break or improper plugging of the cables)
• Missing power supply of the Tankvision unit

10.2 Resets

10.2.1 Types of Resets
• Reset: 

Restart the system without any additional action.
• Cleanup:

Resets archival data, alarms and events without changing the configuration.
• Factory:

Resets the software to factory default settings, all data is getting lost including network 
settings.

10.2.2 Hardware Reset
• Push the reset button on the front panel of the device and release it in one of the following 

specified reset windows indicated by the Reset LED.
• Releasing the button in a LED ON window has no effect at all, the system keeps on 

running.

10.2.3 User Interface Reset
• Use a Service Code script to perform a reset
• Path: Global Settings / System Diagnostics / Service Code
• Enter one of the given Service Codes and press submit

UserInterfaceReset

Reset Cleanup Factory

LED flash
Hz

LED ON LED flash
2,5 Hz

LED ON LED flash
1,25 Hz

LED ON

0...5 sec 5...10 sec 10...15 sec 15...20 sec 20...25 sec > 25 sec
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11 Repair

11.1 Return
The requirements for safe device return can vary depending on the device type and national 
legislation.

1. Refer to the web page for information:
https://www.endress.com/support/return-material

2. Select the region.

3. Return the device if repairs or a factory calibration are required, or if the wrong device 
was ordered or delivered.

11.2 Disposal

If required by the Directive 2012/19/EU on waste electrical and electronic equipment 
(WEEE), the product is marked with the depicted symbol in order to minimize the disposal 
of WEEE as unsorted municipal waste. Do not dispose of products bearing this marking as 
unsorted municipal waste. Instead, return them to the manufacturer for disposal under the 
applicable conditions.
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